
Welcome to Redmark

Welcome to Epitome's Redmarkî software for the NeXT. Redmark 
complements your standard document processing tools by providing online 
document markup. With Redmark, you can implement a paperless review cycle 
over your network or over the internet - and preserve a few trees.

Satisfaction Guaranteed

We fully expect that you will like Redmark and find it useful in your 
application. However...

Your satisfaction is our primary goal. If, for any reason, you are not 
completely satisfied with Redmark, you can return it within 30 days of 
purchase for a refund.

All we ask is that you
 

• Tell us what you didn't like about Redmark, 
• Deinstall it, and 
• Return the full distribution, including manual. 
• If you purchased Redmark directly from Epitome, we will send you a 

refund of your full purchase price. 

We encourage all resellers of Redmark to pass our guarantee on to you, their 
customer. If the reseller from whom you bought Redmark will not honor our 
guarantee, contact us directly and we will refund the price paid by the reseller.

Customer Support



As a registered user of Redmark, you are entitled to no-charge customer 
support to answer any questions you have about Redmark. No question is too 
small or too trivial. If you don't know how to use Redmark to its fullest, you 
won't be able to get the most out of it. Besides, we like to talk to our customers 
and get their feedback.

We want Redmark to be as bug free as possible. Therefore, we make you the 
following offers: 

• If you find a bug, report it, and help us reproduce it, we will send you free 
the next update that fixes the bug. (An update is a new version that fixes 
problems and may contain minor enhancements. The minor version number 
changes between updates. That is, going from version 1.1 to 1.2 is an 
update.)

• If you encounter a crash, report it, and help us reproduce it, we will send 
you free the next upgrade. (An upgrade is a new version that contains 
extensive enhancements. The major version number changes between 
upgrades. That is, going from version 1.2 to 2.0 is an upgrade.)

• If you have a PostScriptî file that Redmark will not handle, send it to us and 
tell us how you produced it. If it roughly conforms to Adobe's structuring 
conventions and does not have any of the limitations discussed in Chapter 9, 
we will send you free the next update that supports that file.

Remember, features you don't like are not necessarily bugs. But ... we also 
welcome any and all suggestions for and criticisms of Redmark. We want each 
Redmark version to be better than the preceding one ... and we can't fix it if we 
don't know about it.

You can contact Redmark customer support in the way easiest for you.

Voice: (615) 675-0910
Fax: (615) 966-2558
E-mail: 72677.1034@compuserve.com



Mail: Epitome Incorporated
716 Summit Lake Court, Suite 100
Knoxville, TN 37922-3156 USA

Chapter 1
Installing Redmark

This chapter explains how to install Redmark and activate it. You will be 
installing:
• the Redmark or Redview application, 
• the online manual (into the Digital Librarianî),
• the license manager if you have a multi-user license, and 
• a set of example files. 

Installing the Application(s)

Redmark is distributed as a single, compressed Installer package. So, to install 
it, you use the NeXT Installer application.

To install Redmark
1. Insert the distribution diskette labelled Program into your floppy drive. It 

will automatically mount and appear in your Workspace as a floppy named 
RedmarkProgram. 

2. Inside the floppy you will find an Installer package named Redmark.pkg. 
Double-click on the Redmark.pkg icon to run the NeXT Installer 
application.



3. Click on the Install button in the Installer panel to begin the installation. 

4. Designate the folder where you want the files to be installed. 



If used by Install in 

.

Single user Your Apps folder or the workstation's LocalApps folder
Single workstation The workstation's LocalApps folder
Site The server's LocalApps folder or the site's designated 

folder for shared applications

5. The following items will be installed in the folder you designated: 

This Is 

.

Redmark.app The Redmark application

If you purchased Redview, the view-only version of Redmark, you need to 
install it as well. Redview is distributed in an Installer package on a second 
diskette.

To install Redview
1. Insert the distribution diskette labelled Options into your floppy drive. It 

will automatically mount and appear in your Workspace as a floppy named 
RedmarkOptions. 

2. Inside the floppy you will find an Installer package named Redview.pkg. 
Double-click on the Redview.pkg icon to run the NeXT Installer 
application. Or, if you are still running the Installer application, choose 
Open from its Package menu and select Redview.pkg.

3. Click on the Install button in the Installer panel to begin the installation. 
4. Designate the folder where you want the license manager to be installed. It 

can be in the same folder where you installed Redmark.
5. Redview.app will be installed in the folder you designated.



Licensing for Use

As is the case with all commercial software, you don't really buy Redmark 
software – you buy a license to use it. Your Software License Agreement is 
printed on the envelope that contained the Redmark distribution diskette(s).

To help us protect our investment in software development, we ask that you put 
up with the minor inconvenience of entering a license key to register Redmark. 
Redmark will not run unless it is validly registered.

You will have two license keys. The first is a temporary license key so that you 
can begin using Redmark immediately. Your temporary license key is on your 
Software License Agreement. This license key is only good for about two 
weeks. During that time, you need to contact Redmark customer support (see 
Customer Support in the Welcome to Redmark chapter) to obtain your 
permanent license key. You will need to supply the host ID of the computer 
where Redmark is installed to obtain your permanent license key.

If you have a multi-user license, you will also need to install a license manager 
on the application server. If you have only a single computer license, you do 
not need to install the license manager.

To install the license manager
1. Check your Software License Agreement to see what type of license you 

have. If you have a single computer license, you do not have to install the 
license manager. Or, if you have a multi-user license but you already have 
the XNet 6.x license manager (named issd6) from Intelligent Software 
Solutions installed, you do not have to reinstall it. However, if you have a 
previous version of the XNet license manager installed for licensing another 
software product, you should install the new XNet 6.x license manager in 
addition to the previous version.

2. Log into the application server as root. Parts of this installation procedure 
require you to have root privileges. If you do not have root privileges, have 



your system administrator install the license manager.
3. Insert the distribution diskette labelled Program into your floppy drive. It 

will automatically mount and appear in your Workspace as a floppy named 
RedmarkProgram. 

4. Inside the floppy you will find an Installer package named LicenseMgr.pkg. 
Double-click on the LicenseMgr.pkg icon to run the NeXT Installer 
application. Or, if you are still running the Installer application, choose 
Open from its Package menu and select LicenseMgr.pkg.

5. Click on the Install button in the Installer panel to begin the installation. 
6. Designate the folder where you want Redview to be installed. We 

recommend that you install it into the LocalApps folder.
7. The following items will be installed in the folder you designated: 

This Is 

.

issd6 The license manager daemon
install_license_mgr A script file that installs the license manager daemon 
xactive, xclear, Some useful license administration utilities
xhostid, xstat, xwho

8. Complete the installation of the license manager by running the 
install_license_mgr script.  This script installs the license manager daemon, 
issd6, as a service for the internet “super server,” inetd. It does this by 
adding a line to the /etc/inetd.conf file. The license manager daemon will be 
run automatically when needed by Redmark or Redview. 

The installation script also creates a directory, /ISS_Licensing, for use by 
the license manager. Later, the license manager will automatically create a 
subdirectory named /ISS_Licensing/epitome which will contain the licensing 
information and usage statistics for Redmark and Redview.



The following is an example of running the installation script. The 
characters you type are shown in italics.

# install_license_mgr

The license manager needs to be installed only if you have
a network (site) license for Redmark. You can determine this
from your Epitome Software License Agreement.
Do you have a network license for Redmark? [y/n] y

Installing ISS XNet license manager ...

Installing issd6 in /etc/inetd.conf

The license manager keeps license information and statistics 
in the license administration directory /ISS_Licensing. 
This directory is required for license management to work 
properly.
Create /ISS_Licensing? [y/n] y
done
#

To license Redmark for use
1. Check your Software License Agreement to see what type of license you 

have. If you have a multi-user license, install the license manager first as 
described above.

2. Run Redmark. The Registration panel will appear automatically, since 
Redmark has never been registered.



3. Write the Host ID on your Software License Agreement. you will need it to 
obtain your permanent license key.

4. Enter your temporary license key from the Software License Agreement and 
click Register. You can now use Redmark for about two weeks before the 
temporary license expires. 
Note You cannot license Redmark for temporary use by multiple users. If 

you have a multi-user license and several users need to run Redmark 
before you get your permanent license, you must install and 
temporarily license Redmark on each of their computers.

5. Get your permanent license key. Contact our Redmark customer support as 
described in Customer Support in the Welcome to Redmark chapter. You 
will need to give us the following information:

Your name
Your organization (company, university, etc.)
Your mailing address
Your voice and fax phone numbers
Your e-mail address
The Host ID from the Registration panel

We will then issue your permanent license key. Write it on your Software 



License Agreement.
6. When you receive your permanent license key, you will need to re-register 

Redmark. Choose the Register command from the Info menu.
7. Enter your permanent license key and click Register. Now you are fully 

registered and can use Redmark to the full extent of your license.

If you purchased Redview, the view-only version of Redmark, you must license 
it separately. Notice that your Software License Agreement has separate license 
keys for Redmark and for Redview.

To license Redview for use
Follow the same procedure to license Redview as you did for Redmark.

Installing the Online Manual

The Redmark distribution contains a pre-indexed online user's manual that can 
be used with the NeXT Digital Librarian.

To install the online user's manual
1. Insert the distribution diskette labelled Documentation into your floppy 

drive. It will automatically mount and appear in your Workspace as a floppy 
named RedmarkDocs. 

2. Inside the floppy you will find an Installer package named 
RedmarkUser.pkg. Double-click on the RedmarkUser.pkg icon to run the 
NeXT Installer application. Or, if you are still running the Installer 
application, choose Open from its Package menu and select 
RedmarkUser.pkg.

3. Click on the Install button in the Installer panel to begin the installation. 
4. Designate the folder where you want the user's manual to be installed. We 



recommend that you install it into the LocalLibrary folder.
5. The Redmark user's manual will be installed in the folder you designated.
6. Install the user's manual into Digital Librarian by dragging the 

RedmarkUser manual (folder) from the Workspace and dropping  it into a 
Digital Librarian bookshelf.

7. You now can select the Redmark User Manual in the Digital Library and 
search it for specific references or browse through it by section.

Installing the Examples

The Redmark distribution contains several example Redmark documents that 
you can use for testing your Redmark installation – or for just playing with. 
These files were produced from different NeXT applications and are already 
annotated with one or more reviews. 



To install the examples
1. Insert the distribution diskette labelled Documentation into your floppy 

drive. It will automatically mount and appear in your Workspace as a floppy 
named RedmarkDocs. 

2. Inside the floppy you will find an Installer package named 
RedmarkExamples.pkg. Double-click on the RedmarkExamples.pkg icon to 
run the NeXT Installer application. Or, if you are still running the Installer 
application, choose Open from its Package menu and select 
RedmarkExamples.pkg.

3. Click on the Install button in the Installer panel to begin the installation. 
4. Designate the folder where you want the example files to be installed. 
5. A folder named RedmarkExamples will be installed in the folder you 

designated. This folder contains the example Redmark documents.

More About Multi-User Licensing

If you purchased a multi-user license for Redmark, a maximum number n of 
users can run Redmark concurrently. A single copy of the Redmark application 
resides on a server on your network – the application server. Each network user 
can access and run Redmark from that application server. A license manager 
daemon (called issd6) also runs in the background on a server on your network 
– the license server. Normally, the application server and the license server are 
the same computer. 

Entering your license key during registration creates a pool of n licenses for 
Redmark. These licenses are administered by the license manager daemon. The 
license manager keeps the license information for Redmark in files within the 
license administration directory /ISS_Licensing/epitome. This directory and the 
license manager daemon are created during the installation of Redmark.

Whenever you run Redmark, a license is checked out of the pool for you by the 
license manager. When you quit Redmark, your license is checked back in and 
becomes available for another user. If you try to run Redmark when all licenses 
are checked out, you will not be able to continue until a current user finishes 



and frees up a license. (See the Running and Quitting Redmark section in 
Chapter 3.)

You can use the License Information panel within Redmark to see who is 
currently using Redmark. This can be especially useful if all licenses are 
checked out and you have a deadline to meet. Your or your system 
administrator can also use the License Information panel to monitor Redmark 
usage and to troubleshoot any licensing problems. The usage statistics are 
particularly helpful in determining whether your current number of Redmark 
licenses is sufficient.

To see the license information from within Redmark
1. Choose the License Info command from the Info menu. 
2. The License Information panel lets you display

a. the status of your license. For example, it shows whether your license is 
for this single computer or is for several concurrent users from an 
application server.

b. the status of the license server. It shows whether the license manager 
daemon is active or not on the license server.

c. the username and hostname for all users that are currently running 
Redmark.

d. statistics on the usage of Redmark, including the number of users who 
were denied access because all licenses were in use. The usage statistics 
can be displayed by day, by week, by month, or by year.



There are several license administration utilities provided with Redmark: xstat, 
xwho, xactive, and xclear. These utilities are run from the command shell and 
their output can be piped to other programs. With one exception, xclear, the 
same functionality is available from the License Information panel within 
Redmark.

To see Redmark usage statistics
1. Type the following command at a shell prompt

xstat Redmark server /ISS_Licensing/epitome [-d|w|m|
y]



You can display usage statistics by day (-d), by week (-w), by month (-m), 
or by year (-y).  The default is by day.

2. The usage statistics for Redmark by the specified time period will be 
displayed on standard output.

To see who is currently running Redmark
1. Type the following command at a shell prompt 

xwho Redmark server /ISS_Licensing/epitome

2. The username and hostname for each current Redmark user will be 
displayed on standard output.

To determine if the license manager is running on a server
1. Type the following command at a shell prompt 

xactive server  

2. The state (i.e., active or inactive) of the license manager daemon on the 
specified server will be displayed on standard output.

To release any “stuck” licenses
Even if Redmark crashes or is killed, its license should be recovered by the 
license manager within a few minutes. In the unlikely event that a license does 
become “stuck” and unusable, xclear can be used to release all active licenses. 
Notice that it should be used with discretion because it clears all active licenses, 
stuck or not.  Xclear can only be run by the system administrator logged in as 
root.

1. Type the following command at a shell prompt 
xclear Redmark /ISS_Licensing/epitome  

2. All active Redmark licenses will be released.

Late Breaking News



The distribution diskette labelled Program contains a (rich) text file named 
RedmarkReadMe.rtf(d). This file contains useful information that supplements 
or updates the information in this manual. This includes the release notes for 
this Redmark version, any manual errata, and a list of applications with which 
Redmark is known to be compatible. It is worth reading, or at least browsing. 
You can open it with the NeXT Edit application.

Which Version?

When you contact us for help or to report a bug, we will need to know the 
version number of your Redmark application. You can find it easily from the 
Info panel in Redmark.

To see the version number
1. Choose the App Info command from the Info menu. 
2. The Info panel contains the version number.

Chapter 2
The Concept of Paperless Review



This chapter discusses how Redmark fits into the "big picture" of a complete 
document cycle. Redmark works in concert with your other document 
preparation applications to provide paperless review for virtually any 
document. By using the concept of marking up transparent overlays on a 
document image, Redmark easily fits into your current review process.

The Document Cycle

The document preparation process consists of three major activities: authoring, 
reviewing, and producing. Authoring encompasses not only the creation of the 
original document, but the management of the review cycle as well. Reviewing 
is the process of having editors, peers, or supervisors suggest (or make) changes 
to the document. Review and correction is usually an iterative process, the 
review cycle. It culminates with the approval of the final document. Finally, 
producing takes the electronic representation of the document and converts it to 
hard copy. It may require performing color separations and other pre-press 
activities.

For some time, tools such as word processors and page layout programs, have 
been available to assist in the authoring process. The development of page 
description languages, such as PostScript, and the emergence of good computer 
color calibration and separation have helped automate the production process. 
Review, however, has remained the missing piece required for a truly paperless 
document preparation cycle.



Some level of document markup could always be accomplished with the 
standard document creation applications. However, reviewers had to modify the 
original document and it was often difficult to differentiate the reviewer's 
comments from the original document text. Reviewers had to resort to kludges 
like putting all their comments in italics. So, review has remained largely a 
paper-based process.
 
Two recent advances have now made paperless review practical: greater 
internetworking and the availability of standalone or integrated markup tools. 
With local area networks, wide area networks, and the internet, e-mail is 
routinely available to almost anyone with a computer. Thus, it has become easy 
to send documents electronically to a widespread group of reviewers. Further, 
many document creation programs now include some capability for non-
destructive markup of their documents. However, this markup capability can be 
used only on their own documents and one application's implementation differs 
substantially from another's. Standalone markup applications, like Redmark, 
provide the needed document-independent means for the electronic review of 
documents.
 

Reviewing with Redmark

Redmark's role lies exclusively in the review activity. As such, it complements 



the traditional document tools provided by word processor, page layout, 
illustration or drawing, and pre-press programs. Unlike the markup tools 
provided by a specific application, Redmark can review documents produced 
from any application.

Redmark uses the same concept for the markup of documents that you are now 
using. Currently, you create a document in, for example, a word processing 
application. You print out a draft and send it to others for review and comment. 
The reviewers mark their comments on the paper using a red pen and sticky 
(e.g., Post-itî) notes. They return these paper comments to you. You then 
spread their comments out on your desk (or floor) while using the word 
processor to incorporate their recommendations into the document. You repeat 
this review cycle until the final document is ready.

With Redmark, the review cycle becomes completely paperless. You create the 
original document as before, using, for instance, a word processor application. 
However, instead of printing the document to paper, you "print" it to disk. This 
creates a print-image PostScript file that represents exactly how the document 
will appear on the printed page. You then use Redmark to create a review 
package containing the PostScript print-image and other related information 
about the document. You distribute this review package to one or more 
reviewers, usually using electronic mail. Each reviewer uses Redmark to create 
a transparent overlay on top of the print image of the document. These overlays 
are called reviews. A reviewer enters comments into the review using 
Redmark's markup tools - text annotations, an electronic equivalent of the 
sticky note, a palette of standard proofreading marks, simple graphics, imported 
images, and digitized voice. The reviewers cannot change the original 
document; they can only mark their comments on it. Each reviewer returns 
their comments to you, again usually by e-mail. You use Redmark to view their 
comments while simultaneously incorporating the recommendations into the 
document using the word processor. During this revision process, you can 
easily cut and paste between the comments in the reviews and the original 
document being revised. 

Paperless review
with Redmark



A document can be anything that can be produced on or scanned into the 
computer. It can be a letter, a manual, an illustration, a presentation, a 
spreadsheet, or even sheet music. The only restriction is that it must be 
describable by a print-image PostScript file. Any NeXT application can create 
such a file using the Save option in the application's Print command. However, 
since PostScript is a general page specification language, PostScript files created 
on other computers also can be reviewed using Redmark on the NeXT. The 
only consideration is that the PostScript file conform to the structuring 
guidelines set forth by Adobe. 

In Redmark, the author is the person who is responsible for the review cycle. 



Often, the author also created the original document and is responsible for its 
revision. The author could be an engineer, a college professor, a writer, or a 
student. The reviewers are people designated to review and comment on the 
document. A reviewer could be a supervisor, a peer, an editor, or an instructor.
 
Redmark can be applied to a variety of review cycle situations. For example, 
many review cycles can be labelled as author-reviewer. The author creates the 
document and distributes a review package to a group of reviewers or editors. 
These reviewers comment on the document and return those comments to the 
author. The author is then responsible for incorporating the reviewers' 
comments into the document. On the other hand, the classroom environment 
can be labelled as student-instructor. The student creates a paper and submits it 
to the instructor. The instructor creates the review package and grades the 
student's paper. This review package is returned to the student who views the 
instructor's comments and corrects the paper.

Chapter 3
Fundamentals of Redmark

This chapter introduces the basic terminology used in Redmark. For example, 
"author" has a specific meaning within Redmark. This chapter also discusses the 
fundamentals of using Redmark. You are expected to already know how to use 
a NeXT application. That is, you should know what a window is and how to 
use the mouse to operate the NeXTstep user interface. This information is 
covered in the NeXT User's Reference manual.

Authors and Reviewers



In Redmark, two types of people participate in the review of a document: the 
author and one or more reviewers. The author is the person responsible for the 
review cycle. Often, but not always, the author also created the document. 
There is only one author for each document. The author is responsible for:

• Creating the document review package from the original document
• Distributing the document review package to the reviewers
• Collecting the reviews from the reviewers
• Revising the document

The reviewers are people designated to review and comment on the 
document.There can be one or many reviewers of a document. The reviewers 
are responsible for:

• Creating a review overlay
• Marking up the review overlay with their comments
• Submitting the review back to the author

Types of Documents

During the review of a document, you deal with the following types of 
documents: 

This document Is
Of type .

Original The real document. It is created by an application 
Depends on 

other than Redmark, such as a word processor. 
creating

Redmark  can't use this document directly. This 
application

document must be revised using the creating 
application to incorporate the reviewers' comments.

Print-image The background print-image of the original document 



.ps, .eps, or .epsf
PostScript upon which review overlays are placed. This document 

is produced from the original document, usually by 
choosing Save (instead of Print) in the Print panel of the 
creating application.You must choose a print-image 
PostScript document when you create a new document 
in Redmark.

Review package The primary document for review. The author creates
.redmk
a review package document in Redmark from the print-
image PostScript document, distributes it to reviewers, 
and collects submitted reviews into it. The review 

package 
document contains the print-image PostScript, the 

reviews, 
and other document information (like the page layout). 

Distribution A smaller review package document. This document is
.redmk
distributed to reviewers, often by e-mail. Reviewers then 
add their reviews into it using Redmark. 

Submittal A minimum review package document containing only
.redmk
the review(s). This document is returned to the author, 
often by e-mail. The author merges reviews from it into 
the review package document using Redmark.

A PostScript document A Redmark document

Notice that there are three variations of a Redmark document: review package, 
distribution, and submittal. They all have the same extension and icon. The 
only distinction between them is the amount of information they contain about 
the document-under-review and, hence, their size. Redmark handles these 



internal differences transparently, so that the main difference to you is in what 
they are used for.

Tech Note Redmark documents are actually file packages. That is, they are 
folders (directories) that masquerade as single files. A Redmark 
document contains several files. One is a copy of the print-image 
PostScript file. Another contains information on the document, 
such as the author, the page layout, and the document history. 
Each review is also kept as an individual file inside the file 
package.

Running and Quitting Redmark

To run Redmark, double-click its application icon or select Redmark.app in the 
File Viewer and choose the Open command from the Workspace File menu.

The Redmark 
application icon

If you have a multi-user license for Redmark, the number of people who can 
concurrently use Redmark is limited to the number specified on your Software 
License Agreement. If all licensed copies are in use, you will get the following 
panel. You must wait until one of the current users quits before you can use 
Redmark.



When you are finished using Redmark, choose the Quit command from the 
main menu. If there are any open documents containing unsaved changes, you 
will be given the opportunity to save them before Redmark actually quits.

You should quit Redmark only when you are completely finished working in it. 
If you just want to get its windows out of the way temporarily while you work 
on something else, use the Hide command from the main menu instead. Hiding 
miniaturizes Redmark's menu and all open windows into its application icon. 
To unhide Redmark, double-click its application icon. This causes Redmark to 
be reactivated. All of the open document windows will be redisplayed, just as if 
they had never been hidden. Hiding and unhiding takes much less time than 
quitting and restarting.
 



Working with Documents

An open document is displayed in a standard window. You can have many 
documents open at the same time. The document in the main window (in front 
with black title bar) is active and will be referred to as the current document. A 
Redmark document window has all of the standard controls for resizing, 
closing, and scrolling.

To Do this
.

Close window Click in close button or choose Close command from 
Document 

menu.
Miniaturize window Click in close button or choose Close command from 
Document 

menu.
Move window Drag window by title bar.
Resize window Drag resize bar.
Automatically arrange Choose Arrange in Front command from Windows 
menu.
windows.
Bring window to front Click anywhere in window or choose its name from 
Windows menu.
Scroll document Click or press the up and down scroll button.
by small increment
Scroll document Alternate-click the up or down scroll button.
by windowful
Scroll document Drag the scroll knob.
dynamically
Scroll document to Click in the scroll bar (outside of the scroll knob).
any location



There is also a "ribbon" of special controls at the bottom of the document 
window. These controls are used to manipulate the review layers and to jump to 
a specific document page.

To Do this
.

Jump to specific Enter the label of the page into the Page field. A 
page's label is the 
document page page "number" that appears on the printed page and is 
not necessarily 

the sequential number of the page within the 
document. For example, 

to go to page 8, enter 8; but to go to page iii, enter 
iii. Don't forget to 

press the Return or Enter key after entering the page 
label.
Bring review to front Choose the name of the review from the reviews pop-
up list or use its 

assigned numeric keyboard alternative (shortcut key). 
For example, 

the first review opened is assigned the keyboard 
alternative 

Command-1, the second is assigned Command-2, and 
so on. The 

keyboard alternative is shown in the reviews pop-up 
list alongside the 

review name.
Show all reviews Check the Show All button.
simultaneously

A Redmark document window



There are two useful borders that can be optionally displayed on a document 
page: a border around the page margins and a border around the original 



document page. These borders are not really part of the document and will 
never be printed. The display of these borders is separately controlled by your 
individual preferences. 

Optional page borders



Setting Document Information

Information about the document is set through the Document Inspector. 
Document information includes its name, the author, and its revision level. 
Only the author can change the document information; the reviewers cannot.

To set document information

1. Choose the Inspector command from the Tools menu. 
2. Choose Document from the inspector type pop-up list in the Inspector panel.

3. Modify the Name, Author, or Revision information in the Document 
Inspector

Field Can contain 
Defaults to

Name Any text. The name is for the users' convenience in identifying 
Filename
the document. It does not have any significance to Redmark and 
without
is independent of the document's filename.
extension

Author A valid login name. The author has special privilege. Only the 
Creator's
author can change all document information and can view all 
login name



reviews, even ones designated as confidential.
Revision A valid login name. The author has special privilege. Only the 

        1
author can change all document information and can view all 
reviews, even ones designated as confidential.

Setting Document Page Layout

The paper for the review package document is initially set to the paper size 
(e.g., letter or legal) and orientation (portrait or landscape) specified in the 
print-image PostScript file used to create it. 

All comments entered in Redmark must lie within the margins on the paper. 
So, for some documents, you may want to change the paper size, orientation, 
and margins. For example, if the document has narrow margins that do not 
leave sufficient space for comments, you might want to increase the paper size. 
Or, when the document to be reviewed is an EPS illustration for which the 
paper size is not specified, you might want to specify a particular paper size and 
orientation.
 
The paper size, orientation, and margins must be set before the document is 
distributed for review. Once the document is distributed for review or a review 
is added to it, the paper can no longer be changed, even by the author. If this 
weren't the case, each reviewer might use a different paper size or orientation 
and correlation of the reviews would be chaotic.

To set document page layout

1. You must be the document author.
2. Choose the Page Layout command from the Format menu. 
3. Set the layout for document pages using the Page Layout panel.



You can set the smallest default paper size that Redmark will use (you can 
explicitly set it smaller) and the default review margins as an individual 
preference. Your preferences are used every time you create a new document.

To set preferences for paper size and margins

1. Choose the Preferences command from the Info menu. 
2. Set the preferences appropriately.



Correcting a Non-conforming Document Image

Some print-image PostScript files do not completely conform to the standard 
structuring conventions established by Adobe. This usually only happens with 
print-image PostScript files produced on computers that don't use PostScript as 
their primary imaging model, i.e., computers other than NeXT. In these cases, 
the image of the document to be reviewed may not be correctly rendered on the 
page. These problems usually appear as a shift or offset of the document image 
on the page or an image orientation that is off by 90?. 

Most of these PostScript problems can be fixed using the image correction 
features provided in the Document Inspector. 

All corrections to the document image must be performed before the document 
is distributed for review. Once the document is distributed for review or a 
review is added to it, the document image can no longer be manipulated, even 
by the author. To do so would affect the position of the comments relative to 
the elements (e.g., words) in the original document.

To correct the document image



1. You must be the document author.
2. Choose the Inspector command from the Tools menu. 
3. Choose Document from the inspector type pop-up list in the Inspector panel.
4. Use image correction controls to adjust the document image.

Note The Document Inspector must be active to reposition the document 
image by dragging. The document image will highlight when it is 
grabbed. You can then drag the image to the desired position. If you 
can see multiple pages, only the image on the page that is grabbed will 
dynamically move, but when the mouse is released, the images on all 
pages of the document will be repositioned by the same amount.



Protecting Document Confidentiality

The author determines the level of confidentiality to be enforced during the 
document review process. This confidentiality provides protection in addition to 
that already provided by the permissions for folders and files that are part of the 
Mach operating system. The Redmark confidentiality protection is simple to 
use. The review package document and individual reviews can be designated as 
either confidential or not confidential. When a document or review is 
designated as confidential, it is given a password. In order to access a 
confidential document or a confidential review, the user must know the 
appropriate password and must have the operating system permissions to read 
or write it. If a document or review is not confidential, only the operating 
system permissions determine who can access them.

The confidentiality of the document is set through the Document Inspector. 

If document is set as Then

.
Confidential All users, even reviewers, must enter the correct 

document-
specific password to open the document in 
Redmark.

All reviews confidential All reviewers must protect their reviews by making 
them confidential. If "All reviews confidential" is 
not set, it is left up to the individual reviewers 
whether they designate their review as confidential 
or not.

To set document confidentiality

1. You must be the document author.
2. Choose the Inspector command from the Tools menu. 
3. Choose Document from the inspector type pop-up list in the Inspector panel.
4. Set the confidentiality of the document.



You can determine the default confidentiality of your documents with your 
individual preferences. Your preferences are used every time you create a new 
document.

To set preferences for document confidentiality



1. Choose the Preferences command from the Info menu. 
2. Use the Security controls to set the default confidentiality for your 

documents and reviews.

By default, Redmark sets the operating system permissions of the document as:

Permissions Owner Group Other
Read yes yes yes
Write yes yes yes
Execute yes yes yes

If you want to restrict access to the document, use the Inspector tool of the 
Workspace to change the permissions. However, the author and all reviewers 
must have read, write, and execute permissions for the document.(Since a 
Redmark document is a file package, i.e., really a directory, execute permission 
is required to access the files within it.)



Saving the Document on Disk

To save the document on disk

1. Choose the Save or Save As command from the Document menu. 
2. If the document hasn't been saved before, use the standard Save panel to 

give the document a filename and save it in the desired folder.

The print-image PostScript file for the document-under-review is copied into 
the document when it is saved to disk. So, after the document has been saved, 
you can delete the original print-image PostScript file, unless you need it for 
other reasons.

Distributing the Review Package

There are several ways to review a document when there are multiple 
reviewers. The only differences are in how you distribute the document to the 
reviewers and how they return their reviews to you. All other aspects of the 
review process are the same. 



For simultaneous review, a distribution document is prepared and transmitted to 
multiple reviewers at the same time, usually by e-mail or removable media 
(e.g., a floppy). This distribution document is a separate Redmark document 
that contains the minimum information that reviewers need. So, it is somewhat 
smaller than the review package document.

For sequential review, the review package document is transmitted to multiple 
reviewers one at a time, again usually by e-mail or removable media. One 
reviewer will add their review into the document and then forward everything 
along to the next reviewer in line. Note that the document will grow in size as 
it is passed along the review chain. You don't need to create a separate 



distribution document with this distribution method.

For in-place review, the reviewers add their reviews directly into the review 
package document over a networked file system. Several reviews can review the 
document simultaneously with this method. You must make sure that the 
review package document is in a shared folder to which all reviewers have read 
and write permission. When you notify the reviewers that the document is 
ready to review, be sure and tell them the name of the document, where it is 
located, and its password if confidential.

The different means of review can be mixed and matched. That is, you can use 
simultaneous review via Internet e-mail for remote reviewers and in-place 
review for local reviewers.

Regardless of the review method you use, you should formally distribute the 
document so that a complete chronology of document history is maintained for 
tracking the review process. (The document's history can be seen using the 
History Inspector.) Creating a distribution document using the Distribute 
Document command places a "distributed" entry in the document's history. For 
sequential or in-place review, you can simply set the Distributed status in the 
Document Inspector. This also makes a "distributed" entry in the document's 
history.

To distribute the document for simultaneous review

1. You must be the document author.
2. Choose the Distribute Document command from the Distribute menu. 
3. Use the Distribute Document panel to create a distribution document on 

disk. The name of the distribution document should be different from the 
review package document.

4. Send the distribution document to each of the reviewers by e-mail or on 
removable media. (See "To send a document by e-mail" or "To send a 
document by removable media" below.)

To distribute the document for sequential review



1. You must be the document author.
2. Mark the document as distributed in the Document Inspector.

3. Send the review package document to the first reviewer by e-mail or on 
removable media. (See "To send a document by e-mail" or "To send a 
document by removable media" below.) Be sure to include a routing list.

4. When the first reviewer has completed their review, they send the review 
package document along to the next reviewer in line.

To distribute the document for in-place review

1. You must be the document author.
2. Mark the document as distributed in the Document Inspector.
3. Make sure that the review package document is in a folder whose 

permissions allow it to be accessible by all the reviewers on the network. 
The reviewers will need read, write, and execute permission (the defaults) 
for the document itself and read and execute permission for all folders in the 
path to the document. (The users need execute permission on folders in 
order to access their contents.) Folder permissions can be checked and 
modified using the Inspector tool of the Workspace.

4. Notify the reviewers of the file name and location of the document that they 
are to review.

To send a document by e-mail

1. Create your message in NeXTmail.
2. Include the document as an attachment to the e-mail message in NeXTmail 



by
a. dragging the document's icon from your Workspace and dropping it into 

the message
-or-
b. using the Mail Document command from Redmark's Services menu.

3. Send the e-mail message to all of the reviewers using NeXTmail.

To send a document by removable media

1. Insert a removable media (such as floppy or optical disk).
2. Copy the document onto the removable media by dragging the document's 

icon from the Workspace and dropping it on the media's icon. 
3. Send the media to the reviewers by normal mail or "sneakernet."

Chapter 4
Distributing a Document for Review

This chapter discusses how the author prepares and distributes a document for 
review using Redmark. Distributing the document for review is the first step in 
the document review cycle.
 
There are four basic steps in distributing a document for review:

1. Create the document in any document preparation application.
2. Save the document as PostScript from the document preparation application, 

e.g., by "printing" it to disk.
3. Create a review package from the document's PostScript file using Redmark.
4. Distribute the review package to the reviewers, often by e-mail using 



NeXTmailî.

Remember, Redmark is only used for the review cycle. It works in concert with 
other applications to provide the entire paperless review cycle.

Preparing the Document

You don't have to do anything special when you create a document that is to be 
reviewed using Redmark. You prepare your document just as you normally 
would, using your document preparation application of choice. You can use a 
word processing, page layout, illustration, spreadsheet, database, or any other 
type of program.
 

“Printing” the Document as PostScript

Once you have the document ready for review, your next step is to create a 
PostScript file that describes how that document will appear when printed. It is 
this PostScript file that Redmark uses to display the document as a background 
image on top of which reviewers will place their comments. Redmark uses 
PostScript because it is the accepted standard for describing printed pages. By 
using PostScript, Redmark can be used to review documents from virtually any 
application without having to translate the various proprietary file formats used 
by each of those applications. Since PostScript output is available on virtually 
any type of computer, documents from non-NeXT computers can also be 
reviewed.
 
To create a PostScript file from your document

1. If your document preparation application can save its documents as 
PostScript or Encapsulated PostScript (EPS), save the document in one of 
these formats using the application's Save As command. This will produce a 
document file with an extension of .ps or .eps.



Some applications can save 
directly as PostScript or EPS.

- OR -

2. "Print" your document to disk using the Save button in the Print panel of 
the application. This will produce a PostScript file with the extension of .ps.

Print the document to disk 
as a PostScript file.



You may want to "print to disk" even from those applications that can save in 
PostScript format, since this "print image" file will reflect exactly what the 
document will look like when it is printed. All standard NeXT applications can 
print their document to disk through the Print command in their main menu.

Tip Do not choose the Preview button in the Print panel and then print to 
disk from the Preview application. While this will work, it creates a 
larger file that is more difficult for Redmark to work with and is an 
unnecessary step.

You can also produce a PostScript or EPS file from applications on other 
popular computers. Most non-NeXT computers provide some type of a "Save 
as PostScript file" option that can be selected when a document is printed. If 
you can produce a file with extension of .ps, .eps, or .epsf, Redmark can 
probably handle it. See Chapter 9 Compatibility Issues for more information 
about producing PostScript files on non-NeXT computers.
 



Creating the Review Package

Up to this point, all the steps in creating a reviewable document have been done 
in applications other than Redmark. Now, you will use Redmark to convert the 
PostScript print-image file into a Redmark document - the review package. 
Creating a review package is simple. You, the author, specify the print-image 
PostScript file for the document, set the paper size for the reviews, make any 
adjustments in the document image, establish the security (if any) to be 
enforced, and save the review package as a Redmark (.redmk) document.

To create a new review package document

1. Choose the New Document command from the Document menu.
2. Select the print-image PostScript file of the document to be reviewed from 

the Open panel.

There are a few important observations to make at this point: 

• In Redmark, unlike most applications, you must specify an existing file for a 
"new" document. You can only review something that already exists.

• The contents of the document to be reviewed cannot be edited. In Redmark, 
the document-under-review is simply a background over which the 
reviewers will place their comments. 

• Redmark does not change the print-image PostScript file. Redmark will 
make a copy of the print-image PostScript file and include it in the review 
package when you Save the review package document. 

• The review package document is not stored on disk until you Save it. 
• For the remainder of the manual, we will usually refer to the Redmark 

review package document as, simply, the "document."

Multiple Reviews

You can think of reviews as layers over the document. The review that is "on 



top" is referred to as the current review. Only the current review is "active" and 
can be manipulated. You choose the current review from the reviews pop-up 
list at the bottom of the document window. The reviews pop-up list contains 
the names of all of the reviews that are currently open for this document. The 
name of the current review is shown in the button of the reviews pop-up list.

You have the choice of viewing all reviews simultaneously or only one at a 
time. This is controlled by the Show All button at the bottom of the document 
window. With the Show All button checked, all reviews are shown 
simultaneously; otherwise, only one review (the current one) is shown at a 
time. You can easily toggle back and forth between all reviews or just one 
review by clicking the Show All button. The default state of the Show All 
button is controlled by the "Show all reviews simultaneously" preference 
setting (using the Preferences command from the Info menu). 



When all reviews are shown simultaneously, the annotations in the current 



review are displayed in either a different color or a different shade of gray 
from the others. This helps you distinguish the annotations of one review from 
those of another. The colors for the reviews are set as part of your individual 
preferences.

To set review colors

1. Choose the Preferences command from the Info menu. 
2. Use the Colors panel to set the colors for the current review and the other 

reviews.



Saving and Reverting the Review

As with any work you do on a computer, you should periodically save your 
review to disk. If you have made any changes to your review (like adding a 
new annotation or editing an existing one) since you last saved it, the icon in 
the close button for the document's window will be a "broken" X. This 
indicates that one or more of the reviews in the document are different from the 
versions saved on disk. 

To save the review on disk

1. Choose the Save or Save Review command from the Document menu. 

2. The review is saved into the current document.

If you have made changes to your review that you don't like, you can restore 
(revert to) the last saved version of the review. All changes you have made in 
the current review will be lost. If the document contains other reviews that have 
been modified, they are not restored. 

To revert to the last saved version of the review

1. Choose the Revert to Saved command from the Document menu. 
2. Since all of your changes will be lost, you must confirm the Revert to Saved 

command.
3. The last saved version of the current review is restored.

Submitting the Completed Review



When you have completed your review, you should formally submit it to the 
author. This maintains the document history (which can be seen using the 
History Inspector) and helps the author to track the progress of the document 
review process. How you submit your review depends upon the review method 
selected by the author. Refer to the Distributing the Review Package section in 
Chapter 4 for a discussion of the common review methods - simultaneous 
review, sequential review, and in-place review.

To submit your review during simultaneous review

1. You must be the reviewer of the current review.
2. Choose the Submit Reviews command from the Distribute menu. 
3. Use the Submit Reviews panel to create a submittal document on disk. This 

submittal document is a separate Redmark document that contains only the 
review and information about it. So, it is significantly smaller than the 
review package document. The name of the submittal document should be 
different from the review package document.

4. Send the submittal document to the author by e-mail or on removable 
media.

To submit your review during sequential review

1. You must be the reviewer of the current review.
2. Mark the review as submitted in the Review Inspector.

3. Send the review package document on to the next reviewer in line by e-mail 



or on removable media.

To submit your review during in-place review

1. You must be the reviewer of the current review.
2. Mark the review as submitted in the Review Inspector.

You can send your submittal as an attachment to an e-mail message or as a file 
on removable media (such as floppy or optical disk). See "To send a document 
by e-mail" or "To send a document by removable media" in the Distributing a 
Document for Review section of Chapter 4.

Opening, Closing, and Deleting Reviews

If you are a reviewer and you open a document, all reviews that you own are 
automatically opened along with it. Or, you can set your preferences so that all 
the reviews you have access to (which may include those owned by other 
reviewers) are automatically opened. If you are the author of the document that 
you open, all reviews in the document are automatically opened for you.

To set preference for reviews automatically opened

1. Choose the Preferences command from the Info menu.
2. Set your Documents preference to determine which reviews will be 

automatically opened for you when you open a document.



To explicitly open a review

1. Choose the Open Review command from the Document menu.
2. Select the review or reviews to open from the Open panel.



3. If the reviewer designated the review to be confidential, you must supply the 
correct password before you can see the review.

4. The selected reviews are opened and displayed in the current document 
window. 

To remove some of the clutter of multiple reviews, you can selectively close 
reviews. Closing the current review removes it from display and from the 
reviews pop-up list.You can reopen any closed review using the Open Review 
command from the Document menu.

To close the current review

1. Choose the Close Review command from the Document menu. 
2. If you have unsaved changes in your review, you will be given a chance to 

save before the review is closed.
3. The current review is closed.

You can also delete the current review from the document. Note the difference 
between Close Review and Delete Review. Close Review removes the current 
review from display but leaves it in the document. Delete Review removes the 
current review from display and removes it from the document.

To delete the current review

1. Choose the Delete Review command from the Document menu. 
2. Since deletion is irreversible, you must confirm the Delete command before 

the review is actually deleted.
3. The current review is removed from the document.

More About Reviews

Only you can modify your reviews. The author and other reviewers can only 
view your reviews. Likewise, you cannot modify another's review. There are 
several ways to tell if the current review is editable. The easiest way is to look 



at the review name in the reviews pop-up list button. If the name is italicized, 
you cannot edit the current review.

The Review Inspector also shows whether the current review is editable or not.

The Document Inspector lists all reviews for the current document and gives 
their status.



Printing Reviews

Although one of the purposes of an online document review cycle is to 
eliminate paper, you can print the reviews if you wish. What you see displayed 
for the current document is what is printed. That is, if one review is shown, one 
is printed (along with the underlying document, of course). If all reviews are 
shown, all are printed. If no reviews are shown, only the document is printed. 
Optionally, the text of any note annotations can be printed at the end. Of 
course, you will not be able to print the contents (digitized voice or sound) of 
Lip Service annotations. 

Note As a reviewer, you have no control over the page layout for the reviews 
(and document). The author must establish the review page layout 
before distributing the document for review. See the Setting Document 
Page Layout section in Chapter4. However, you can set the page layout 
for the text of any note annotations.



To print the displayed reviews

1. Choose the Reviews command from the Print menu. 
2. Use the Print panel to print, fax, or preview the reviews.

To set the page layout for notes

1. Choose the Page Layout command from the Format menu. 
2. Set the page layout for notes using the Page Layout panel.



Tech Note If you are printing the text of note annotations, they are printed 
as a second print job. As a result, you will probably notice that 
the Print panel disappears briefly between printing the reviews 
and printing the notes.



Chapter 5
Reviewing a Document

This chapter discusses how a reviewer uses Redmark to review a document. As 
part of the paperless review cycle, the author sends each reviewer or gives each 
reviewer access to a Redmark review package document. Each reviewer adds 
their review into this document, then returns it to the author. 

There are three basic steps to reviewing a document with Redmark:

1. Create a transparent overlay - a review - for the document.
2. Enter comments using the Annotations tools, e.g., Lip Service, sticky notes, 

or proofreading marks.
3. Submit the review to the author.

This chapter covers the first and last steps. Chapter 6 Entering Comments will 
cover the middle step of markup.

Receiving the Document

As a reviewer, you will receive the document to review in one of three ways:

• an attachment in an e-mail message,
• a file on removable media, like a floppy disk, or
• a document directly accessible over a networked file system.

If you received the document in an e-mail message, you will need to extract it 
before you can begin your review.

To extract the document from an e-mail message



1. Open the mail message in NeXTmail. The distributed document will appear 
as a Redmark document icon within the message.

2. Extract the document by
a. dragging the document icon from the e-mail message and dropping it 

into a folder in your Workspace
-or-
b. double-clicking on the document icon to run Redmark. Then, save the 

document using the Save As command from Redmark's Document menu.
3. You are now ready to review the document.

If you received the document on a removable media, we recommend that you 
copy it onto your local hard disk before starting your review. Just drag the 
Redmark document icon from the removable media into a folder in your 
Workspace. You could leave the document on the removable media and review 
it from there; however, it will be slower.



If the document is to be accessed through a networked file system, you are 
immediately ready to proceed. 

Creating a Review

Each reviewer must create at least one review. Each review provides a 
transparent overlay on the document into which the reviewer enters comments 
and annotations. Each review is independent and is a separate layer. A review 
provides the computer equivalent of laying a mylar sheet over a paper 
document and marking on it with a red grease pencil.

A review will be created for you automatically the first time you open the 
document to be reviewed, if you are not the author. (The author usually doesn't 
need a review overlay.) However, you can override this default behavior with 
your preferences as will be described shortly.

To open the document

1. Choose the Open command from the Document menu.
2. Select the document to be reviewed from the Open panel.
3. If the author designated the document to be confidential, you must supply 

the correct password before you can work on (or even see) the document. If 
you have not been given a password, cancel the Password panel and contact 
the author.

4. The document is opened in a new window and a new, empty review is 
created (unless you are the author). The new review is named the same as 
your login name. 

Since a new review is completely transparent and contains no annotations, all 
you see in the window is the document that you will review. You cannot 
change the document that you are reviewing. You can only add annotations to 
the review overlay on top of the document.



You can create more than one review if you wish. Or, the author can create a 
review.

To explicitly create a new review

1. Choose the New Review command from the Document menu.
2. A new, empty review is created. Since each review must have a unique 

name, the second review will be named as your login name with the number 
1 appended to it, the third will have a number 2 appended, and so on.

The author of a document usually does not need a review overlay. So, by 
default, a review is not automatically created when you use the New Document 
command to open a PostScript file or use the Open command to open a 
Redmark document that you created. However, you can set your preferences so 
that a review overlay will be created for you automatically every time you open 
a document if it doesn't already contain a review of yours.

To set preference for automatic review creation

1. Choose the Preferences command from the Info menu.
2. Set your Documents preference to determine when a review overlay will be 

automatically created for you.



Setting Review Information

Information about the review is set through the Review Inspector. Review 
information includes the review's name and the login name of the reviewer who 
created it. Only the reviewer can change the review information; other 
reviewers and the author cannot.

To set document information

1. Choose the Inspector command from the Tools menu. 
2. Choose Review from the inspector type pop-up list in the Inspector panel.

3. Modify the Name and Reviewer information in the Review Inspector

Field Can contain 
Defaults to

Name Any text. The name is for the users' convenience in 
Login name of
identifying the review. However, the review name must the 
reviewer.
be unique within the document.



Reviewer A valid login name. Only the reviewer can annotate the 
Login name of
review overlay and change review information. the 
reviewer.

Protecting Review Confidentiality

You can designate your review as confidential or not confidential. When a 
review is confidential, it is given a password. In order to see a confidential 
review, any user, other than the reviewer and the document author, must know 
the correct password. The document author can see all reviews regardless of 
whether they are confidential or not.

The author can designate that all reviews for a document be confidential. If 
"All reviews confidential" is set for the document (see the Document 
Inspector), your review must be confidential. If you have not explicitly set your 
review as confidential, you will be required to assign it a password when you 
save your review for the first time. 

The confidentiality of the document is set through the Review Inspector. 

If Is set Then
.

Review Confidential Users, other than the reviewer and the author, 
must enter 

the correct review-specific password to see the 
review in 

Redmark.
Document All reviews You must protect your review by making it 
confidential. If 

confidential "All reviews confidential" is not set, you can 
designate your 

review as either confidential or not 
confidential at your 



discretion.

To set review confidentiality

1. You must be the reviewer.
2. Choose the Inspector command from the Tools menu. 
3. Choose Review from the inspector type pop-up list in the Inspector panel.
4. Set the confidentiality of the document.



You can determine the default confidentiality of your reviews with your 
individual preferences. Your preferences are used every time you create a new 
review.

To set preferences for review confidentiality



1. Choose the Preferences command from the Info menu. 
2. Use the Security controls to set the default confidentiality for your reviews.

An Evaluation

It is often useful to give a short, perhaps quantitative, evaluation to a document 
in addition to detailed comments. The most obvious example is the assignment 
of a grade to a student's paper. You enter your evaluation in the field provided 
in the Review Inspector.

To enter review evaluation

1. You must be the reviewer.
2. Choose the Inspector command from the Tools menu. 
3. Choose Review from the inspector type pop-up list in the Inspector panel.
4. Enter the evaluation of the document.



Creating Annotations

Selector

The selector tool is used to select, move, and resize existing annotations in the 
current review. If another tool is in effect, you can force the selector tool 
temporarily active by holding down the Control key.

The use of the selector tool is discussed in the Working with Annotations 
section later in this chapter.

Sticky notes

The note tool is used to create a note annotation that conveniently holds long 
text comments. You use note annotations in reviews like you use yellow sticky 
notes on paper. There are two types of annotations that hold text comments - 
note annotations discussed here and text annotations discussed later. 

Note annotations consist of two parts: the note annotation button that appears in 
the review and the separate note annotation window that contains the actual text 
comments. Normally, only the note annotation button appears in the review, so 
the text comments don't obscure any of the document. The note annotation 
window can be easily opened to view or enter the text comments.



A note annotation button can have three states depending upon the text it 
contains:

To create a note annotation

1. Choose the note tool from the Annotations palette. The cursor shape will 
change to a small notepad when moved over the review. 

2. Place the note annotation into the review by clicking. An empty note 
annotation button will appear at that location. 

3. You can grab and move the note annotation button, but you cannot resize it. 

The note annotation is initially given the unimaginative name "Note n", but you 
can change the name to anything you wish. When created, the name of the note 
annotation is automatically selected, so you can simply type in a new name. If 
you want to change the name later, click in the name and edit it as you would 
any other text. Note that the cursor changes to an I-beam shape whenever it is 



over the name of a note annotation to indicate that the name is editable. The 
name of a note annotation is just a reference for your, and the author's, 
convenience and has no other significance within Redmark. 

To open a note annotation window

1. Double-click on the note annotation button in the review. 
2. A separate note annotation window will open to display the text comments. 

This window will be titled with the name of the corresponding note 
annotation button. 

To enter comments into a note annotation

1. Click in the open note annotation window to make it the key window (a 
black title bar).

2. If you can edit the note text, the cursor will change to an I-beam when it is 
over the note window.

3. Enter your comments into the note annotation window. 
4. Use the commands in the Font and Format menus and the standard Font 

Panel to change the style of your text comments (e.g., using bold for 
emphasis).

5. Move and resize the window as you wish. Note that moving the window 
does not move the corresponding note annotation button.

To close a note annotation window

1. Click the close button of the note annotation window. The window will 
shrink into the corresponding note annotation button.

Lip Service

The Lip Service tool is used to create a Lip Service annotation that contains 



digitized voice (or other sounds). A Lip Service annotation is much more 
expressive than mere text and provides that "personal touch." It is often used 
when you want to convey emotions in your comments, like anger or elation. 
Don't get carried away, however, as voice does make the review larger - a 
possible consideration if you are tight on disk space or return your comments 
via Internet e-mail.

To create a Lip Service annotation

1. Choose the Lip Service tool from the Annotations palette. The cursor shape 
will change to small lips when moved over the review. 

2. Place the Lip Service annotation into the review by clicking. A Lip Service 
annotation button will appear at that location. 

3. You can grab and move the Lip Service annotation button, but you cannot 
resize it. 

To play a Lip Service annotation

1. Double-click on the Lip Service annotation button in the review. 
2. The sound will be played. You can click in the Lip Service annotation while 

the sound is playing to stop it before the end. 

To record digitized voice in a Lip Service annotation

1. Choose the Inspector command from the Tools menu. 
2. Choose Annotation from the inspector type pop-up list in the Inspector 

panel.
3. Select the Lip Service annotation in the review.

Note For your convenience, the Lip Service Inspector is automatically 
displayed whenever you create a new Lip Service annotation. 

4. Use the controls in the Lip Service Inspector to record and edit your voice 
message. The Lip Service Inspector operates like Lip Service in NeXTmail, 



that is, like a tape recorder.

To edit the recorded message



1. Select a segment of the recorded sound waveform.
2. You can use the play button to hear and verify that you have selected the 

correct message segment.
3. Edit the selected message segment

a. Record over the segment using the Record button.
- or -
b. Remove the segment using the Cut command.
- or -
c. Use Cut, Copy, and Paste commands to rearrange the message.

Direct and Boxed Text

You can enter short text comments directly into your review. Unlike the note 
annotation, these text annotations appear directly over the document. The text 
annotation is equivalent to typing your comments in the margins or between the 
lines on a paper document. 

You can select one of two types of text annotation from the Annotations palette 
- direct or boxed. The direct text has a transparent background and is equivalent 
to using a typewriter. The boxed text is contained in an opaque, bordered box 
that expands and contracts to fit the text. You can change the background and 
border of either type of text annotation using the Text Inspector.

To create a text annotation

1. Choose either the direct text or the boxed text tool from the Annotations 
palette. The cursor shape will change to an I-beam when moved over the 
review. 

2. Place the text annotation into the review by clicking. A blinking text 
insertion bar will appear at that location. 

3. Type your text comment.



Direct text Boxed text

To edit the text in a text annotation

1. Move the cursor over the text annotation. The cursor shape will change to an 
I-beam. You do not have to choose one of the text annotation tools.

2. Click in the text annotation to place the blinking text insertion bar there.
3. Edit the text in the annotation as you would any other text.

You can use the commands in the Font and Format menus and the standard 
Font Panel to change the style of your text comments (e.g., to use bold for 
emphasis). The changes apply to whatever portion of the text is currently 
selected or to the entire text if the text annotation is selected.

You can move and resize a text annotation. Whenever the text annotation is 
resized, its text automatically wraps to fit the new size. However, because the 
current tool changes to the text editing tool (I-beam) whenever you are over the 
body of a text annotation, you must take special care to resize and move a text 
annotation. Using the selector tool, click on the border of the text annotation to 
select it. (There is an invisible border around an "unbordered" text annotation.) 
To resize the text annotation, grab one of the rectangular handles and drag it. 
To move the text annotation, grab its border in any place except on a handle 
and drag it to the desired location. Be sure that you grab the text annotation on 
its border, because, if you stray into the text, your cursor will become the 
editing tool and you will end up editing instead of resizing or moving. You can 
avoid this problem by holding down the Control key. This temporarily forces 
the selector tool to be active, even when the cursor is positioned over the text of 
a text annotation. With the selector tool forced active, you can select and move 
the text annotation without needing to be precisely on its border.

You can use the Text Inspector to change the background and border of a text 
annotation. In fact, the only difference between the direct text annotation tool 
and the boxed text annotation tool is the default attributes of the two tools.



Lines and Arrows

You can draw lines, with or without arrowheads, in the review using the line or 
arrow Annotations tool. For example, you can use a line to strike out a passage 
or use an arrow to direct the author's attention to a specific point.

To create a line or arrow annotation

1. Choose either the line or the arrow tool from the Annotations palette. The 
cursor shape will change to a cross when moved over the review. 

2. Click in the review where you want the line to start. Hold the Alternate key 
down when you click if you want the line constrained to angles that are 
multiples of 15® (30®, 45®, 60®, etc.).

3. Drag the mouse to stretch out the line. You can see the line being drawn as 
you move the mouse.

4. When you have the line drawn like you want, release the mouse button.
5. You can grab and move the line or arrow annotation or select and resize it. 

You can use the Line Inspector to change the line width and arrowhead of a 
line annotation. In fact, the only difference between the line annotation tool and 
the arrow annotation tool is the setting of the default arrowhead attribute.

Circles and Ellipses

You can draw circles and ellipses in the review using the circle Annotations 
tool. For example, you can "circle" a passage about which you are commenting.

To create a circle or ellipse annotation



1. Choose the circle tool from the Annotations palette. The cursor shape will 
change to a cross when moved over the review. 

2. Click in the review where you want one "corner" of the circle to start. Hold 
the Alternate key down when you click if you want to draw a perfect circle. 
If you don't hold down the Alternate key, you will draw an ellipse.

3. Drag the mouse to stretch out the circle. You can see the circle being drawn 
as you move the mouse.

4. When you have the circle drawn like you want, release the mouse button.
5. You can grab and move the circle annotation or select and resize it. 

You can use the Circle Inspector to change the line width and fill of a circle 
annotation.

Rectangles and Squares

You can draw rectangles and squares in the review using the rectangle 
Annotations tool. For example, you can create a simple illustrative diagram.

To create a rectangle or square annotation

1. Choose the rectangle tool from the Annotations palette. The cursor shape 
will change to a cross when moved over the review. 

2. Click in the review where you want one corner of the rectangle to start. 
Hold the Alternate key down when you click if you want to draw a square.

3. Drag the mouse to stretch out the rectangle. You can see the rectangle being 
drawn as you move the mouse.

4. When you have the rectangle drawn like you want, release the mouse button.
5. You can grab and move the rectangle annotation or select and resize it. 

You can use the Rectangle Inspector to change the line width and fill of a 
rectangle annotation.



Curves

You can draw curves in the review using the curve Annotations tool. For 
example, you can use curves to build neat things.

To create a curve annotation

1. Choose the curve tool from the Annotations palette. The cursor shape will 
change to a cross when moved over the review. 

2. Click in the review where you want the curve to start.
3. Drag the mouse to stretch out the curve. The direction of your first mouse 

move determines the shape of the curve, i.e., whether the curve extends 
horizontally or vertically from the start point. You can see the curve being 
drawn as you move the mouse. If the shape is wrong, you can reset it by 
dragging the end point back to the start point, then drag it out in the proper 
direction.

4. When you have the curve drawn like you want, release the mouse button.
5. You can grab and move the curve annotation or select and resize it. 

You can use the Curve Inspector to change the attributes of a curve annotation.

Polygons

You can draw open or closed polygons in the review using the polygons 
Annotations tool. For example, you can use an open polygon to easily draw a 
sequence of connected lines.



To create a polygon annotation

1. Choose the polygon tool from the Annotations palette. The cursor shape will 
change to a cross when moved over the review. 

2. Click in the review where you want the polygon to start.
3. Drag the mouse (holding the button down) to stretch out the first side of the 

polygon. You can see the curve being drawn as you move the mouse.

4. Release the mouse button to establish a corner of the polygon. This fixes the 
end of one side and starts the next side. Click and drag to stretch out the 
second side.

5. Double-click to establish the last corner. This fixes the end of the last line 
segment.

6. If the Closed attribute is set for the polygon tool, the polygon will be closed 
automatically. That is, a line will be added to connect the end of the last line 
segment to the start of the first line segment.

7. You can grab and move the polygon annotation or select and resize it, but 
you can't reshape it. 

You can use the Polygon Inspector to change the line width, closure, and fill of 
a polygon annotation.



Scribbles

You can do freehand drawing in the review using the scribble Annotations tool.

To create a scribble annotation

1. Choose the scribble tool from the Annotations palette. The cursor shape will 
change to a pencil when moved over the review. 

2. Click in the review where you want the scribble to start.
3. Drag the mouse to draw the freehand shape. You can see the scribble being 

drawn as you move the mouse. Move the mouse slowly to get the best 
fidelity of the scribble "ink" to your movements.

4. When you finish scribbling, release the mouse button.
5. You can grab and move the scribble annotation or select and resize it, but 

you can't reshape it. 

You can use the Scribble Inspector to change the line width and arrowhead of a 
scribble annotation.

Delete

You can draw the delete proofreading mark in the review using the delete 
Annotations tool. The delete mark is drawn just like a line. In fact, the delete 
mark is simply a line with a curly-q on the end. The delete mark is used to 
strike out a letter, word, or passage.

To create a delete annotation

1. Choose the delete tool from the Annotations palette. The cursor shape will 
change to a cross when moved over the review. 

2. Click in the review where you want the "tail" of the delete mark to start. 



Hold the Alternate key down when you click if you want the delete mark 
constrained to angles that are multiples of 15® (30®, 45®, 60®, etc.).

3. Drag the mouse to stretch out the delete mark. You can see the delete mark 
being drawn as you move the mouse.

4. When you have the delete mark drawn like you want, release the mouse 
button.

5. You can grab and move the delete annotation or select and resize it. 

You can use the Proofreading Mark Inspector to change the curly-q orientation 
of a delete annotation.

Transpose

You can draw the transpose proofreading mark in the review using the 
transpose Annotations tool. The transpose mark is drawn similarly to a 
rectangle. The transpose mark is used to transpose (swap) two letters, words, or 
passages.

To create a transpose annotation

1. Choose the transpose tool from the Annotations palette. The cursor shape 
will change to a cross when moved over the review. 

2. Click in the review where you want one corner of the transpose mark to 
start.

3. Drag the mouse to stretch out the transpose mark. You can see the transpose 
mark being drawn as you move the mouse.

4. When the transpose mark encloses the two passages to be transposed, release 
the mouse button.

5. Use the selector tool to reposition the center separation line by dragging its 



handle. The separation line should lie in between the two passages to be 
transposed.

6. You can grab and move the transpose annotation or select and resize/reshape 
it. 

You can use the Proofreading Mark Inspector to change the attributes of a 
transpose annotation.

Other Proofreading Marks



You can place standard proofreading marks in the review using the appropriate 
Annotations tool. The standard proofreading marks form an established 
"shorthand" for indicating changes to the document.

To create a proofreading mark annotation

1. Choose a proofreading tool from the Annotations palette. The cursor shape 
will change to a checkmark when moved over the review. 

2. Place the proofreading mark annotation into the review by clicking. The 



proofreading mark will appear at that location. 
4. You can grab and move the proofreading mark annotation or select and 

resize it. 

You can use the Proofreading Mark Inspector to change the attributes of a 
proofreading mark annotation.

Importing Images and Sounds

You can import images and sounds into your review by "drag and drop" from 
the Workspace. Images can be in either Tag Image File Format (TIFF) or 
Encapsulated PostScript (EPS) format. Sounds are contained in a sound file 
(one with an extension of .snd).

A TIFF file An EPS file A sound file

To import an image

1. From the Workspace, drag the icon of the TIFF or EPS file over the review 
and drop it there.

2. The image within the file will appear where it was dropped. It is now 
appropriately called an image annotation.

3. You can grab and move the image annotation or select and resize it.

Note Unlike other annotations, the color of an image annotation is not 
affected by the color of the review. That is, annotations on the current 
(topmost) review are normally displayed in a different color or shade of 
gray than other (lower) reviews. However, an image annotation is 
always displayed in its original colors, exactly as drawn, regardless of 
whether it is on the topmost review or not.

To import a sound



1. From the Workspace, drag the icon of the SND file over the review and 
drop it there. 

2. A Lip Service annotation containing the sound will be created at that 
location.

3. You can grab and move the Lip Service annotation, but you can't resize it. 
4. You can play the sound by double-clicking on the Lip Service annotation 

and you can edit it using the Lip Service Inspector

Summary of Tools

Resiz-
Annotation Created by able? Alternate key

Sticky note Placing with tool No No effect
Lip Service Placing with tool or No No effect

dragging and dropping
sound file icon

Direct text and Placing with tool Yes No effect
boxed text
Line and arrow Drawing with tool Yes Constrains to angle

that's multiple of 15®
Circle Drawing with tool Yes Constrains to perfect

circle
Rectangle Drawing with tool Yes Constrains to square
Curve Drawing with tool Yes No effect
Polygon Drawing with tool Yes No effect
Scribble Drawing with tool Yes No effect
Delete Placing or drawing Yes Constrains to angle

with tool that's multiple of 15®
Transpose Placing or drawing Yes No effect

with tool
Other proofread- Placing with tool Yes No effect
ing marks



Image Dragging and dropping Yes No effect
TIFF or EPS file icon

Working with Annotations

Once you have created an annotation, you may wish to modify it. For example, 
you may need to move it slightly, resize it, or even delete it. These operations 
are performed in the same manner regardless of the type of annotation.

Selecting

An annotation is usually left selected after it is created. Selected annotations are 
highlighted. Resizable annotations are highlighted by showing rectangular 
handles at each corner and side. These handles are used for resizing. Non-
resizable annotations are shown highlighted with a gray background (since they 
don't need handles).

A selected, resizable A selected, non-
annotation resizable annotation

You use the selector tool to select an annotation. Remember, holding down the 
Control key temporarily activates the selector tool.

Do this To .

Click on annotation Select the annotation.
Shift-click on annotation Add annotation to selection.
Alternate-click on annotation Select the annotation behind another
Drag selection rectangle around Select all annotations completely 



enclosed.
annotations
Alternate-drag selection rectan- Select all annotations touched.
gle across annotations

To select annotations one-at-a-time
 
1. Make the selector tool active so the cursor appears as a pointer . 

a. Choose the selector tool explicitly.
- or -
b. Hold down the Control key to temporarily activate the selector tool.

2. Hold the Shift key down if you want to add this annotation to other 
annotations that are already selected.

3. Click on a non-transparent portion of the annotation. For example, to select 
a rectangle annotation, you must click on its border, not on its inside 
(assuming the inside is transparent). You don't have to hit the annotation 
exactly, but you do have to be reasonably close.

4. The annotation will become highlighted.

To select several annotations at once
 
1. Make the selector tool active so the cursor appears as a pointer . 

a. Choose the selector tool explicitly.
- or -
b. Hold down the Control key to temporarily activate the selector tool.

2. Click in the review, but not on an annotation.
3. Drag the selection rectangle around the annotations to be selected. If you 

held the Alternate key down when you clicked, the selection rectangle only 
needs to "touch" an annotation to select it. Otherwise, an annotation must be 
completely enclosed to be selected.



4. The annotations will become highlighted.

To select all annotations at once

1. Choose the Select All command from the Edit menu. 
2. All annotations in the current review will become selected.

Unless you have the Shift key down, any new selection will cause all currently 
selected annotations to be deselected. A Shift-click on an already selected 
annotation will deselect only it, leaving other selected annotations still selected. 
Simply clicking on an annotation that is already selected has no effect. If you 
click in the review and not on any annotation, all annotations that are currently 
selected will be deselected. You can also deselect all annotations by choosing 
the Deselect All command from the Edit menu.

Moving

To move an annotation, just drag it. You don't even have to select it first. 
However, if the annotation is selected, be careful and don't grab one of its 
handles or you will resize it instead of move it. 

For fine positioning, you can also nudge an annotation using the cursor keys. 
To nudge an annotation, select it. Now, each time you press one of the cursor 
(arrow) keys, the annotation will move slightly in the direction of the key 
arrow.

Annotations must lie within the page margins set for the document. If you 
move an annotation outside of the margins, it will automatically "snap back" 
within the margins when it is released. The page margins are set by the author 
and cannot be changed by the reviewers. You can display the page margins by 



setting your "Show page margins" preference (using the Preferences command 
from the Info menu).

Resizing

You resize an annotation using its handles. Note that annotations that don't have 
handles when selected can't be resized. Corner handles resize an annotation in 
both height and width, while side handles only resize it in one dimension.

To resize an annotation

1. Select the annotation to be resized. Handles should appear when it is 
highlighted. If not, the annotation cannot be resized.

2. Drag one of the handles until the annotation reaches the desired size.

Corner handles allow resiz- Side handles allow resizing
ing both width and height.  in only one dimension.

3. The annotation will remain selected after you release it, in case you want to 
nudge it or resize it some more.

Most annotations use the Alternate key to constrain resizing from a corner 
handle. It usually keeps the aspect ratio (the ratio of width versus height) of the 
annotation constant. Note that the resizing constraints may be different than 
those for creating. For example, a rectangle is constrained to be square during 
creating but is only constrained to maintain its existing aspect ratio during 
resizing.

The Alternate key Forces this constraint on
during corner resizing the annotation .

Text Maintains aspect ratio of border



Line and arrow Angle is multiple of 15®
Circle No effect
Rectangle Maintains aspect ratio
Curve Angle of imaginary line between

ends is multiple of 15®
Polygon Maintains aspect ratio
Scribble Maintains aspect ratio

Ordering

Within a review, annotations have an ordering from front to back. When 
annotations overlap, their ordering determines which annotation lies on top of 
the other. For example, if two annotations overlap and are opaque, the 
annotation that is in front will obscure part (or possibly all) of the one behind 
it. 

Note Annotations are ordered only within the same review. The reviews 
themselves have a similar ordering from front to back within the 
document. Annotations on the front review can cover annotations on the 
other reviews.

Whenever a new annotation is created, it is placed at the front. You control the 
ordering of existing annotations by either bringing them to the front or sending 
them to the back.

When you select an annotation, it temporarily comes to the front. When you 
deselect it, it returns to its proper ordering.

To reorder annotations

1. Select the annotation(s) to be reordered. When an annotation is selected, it 
temporarily comes to the front.



Before selection After selection

2. Choose either the Bring to Front or the Send to Back command from the 
Format menu.

3. The annotations are reordered.

Bring to Front Send to Back

To select obscured annotations

1. Select the front annotation by clicking on it.
2. Alternate-click on the selected (front) annotation to select the one behind it.
3. Each time you alternate-click, the next annotation further back in the order 

is selected.

Deleting, Duplicating, and Pasting

To delete annotations

1. Select the annotation(s) to be deleted.
2. Delete the selected annotation(s) by

a. Pressing the Delete key.
- or -
b. Choosing the Delete command from the Edit menu.
- or -
c. Choosing the Cut command from the Edit menu. This also copies the 

annotations to the pasteboard, from which they can be pasted.

Note Be careful deleting annotations, there is no undo. However, if you 
inadvertently Cut something you didn't mean to (say, you really meant 



to Copy), you can simply Paste it back. 

To duplicate annotations with Copy and Paste

1. Select the annotation(s) to be duplicated.
2. Copy the selected annotation(s) to the pasteboard by choosing the Copy (or 

Cut) command from the Edit menu.
3. Indicate where you want the annotation placed in the review by clicking at 

that location with the selector tool.
4. Paste the annotation(s) into the review by choosing the Paste command from 

the Edit menu.

Using Copy and Paste with text is discussed in the next section, Working with 
Text.

To duplicate annotations with Duplicate

1. Select the annotation(s) to be duplicated.
2. Duplicate the selected annotation(s) by choosing the Duplicate command 

from the Edit menu.

The Paste and Duplicate commands are "smart." You can create a sequence of 
equally-spaced duplicate annotations by successively pasting or duplicating.

To create several equally-spaced annotations

1. Select the annotation(s) to be duplicated.
2. Duplicate the selected annotation(s) once by 

a. Choosing Copy, then Paste.
- or -
b. Choosing Duplicate.

3. Move the duplicate annotation to the desired spacing from the original. Do 
not deselect it before moving it.



4. Choose Paste. A second duplicate will be created with the same spacing 
from the first duplicate that the first duplicate has from the original.

5. Repeat Paste to create as many duplicates as desired.

You can also paste TIFF or EPS images or sounds from the pasteboard into the 
current review. Pasting an image creates an image annotation. Pasting a sound 
creates a Lip Service annotation. Pasting is an alternative to the "drag and 
drop" importing described earlier.

To paste images or sounds from another application

1. Copy the image or sound onto the pasteboard from another application.
2. Make the Redmark document window the main window (so its title bar is 

black).
3. Indicate where you want the annotation placed in the review by clicking at 

that location with the selector tool.
4. Paste the pasteboard contents into the review as an annotation by choosing 

the Paste command from the Edit menu.

Using Copy and Paste between applications is discussed further in the 
Incorporating Comments into the Original Document section of Chapter 7 
Revising the Original Document. 

Grouping

It is often convenient to consider several annotations as a single, group 
annotation. For example, if you make a drawing which is composed of several 
graphic annotations (like lines and circles), you might want to group them into 
one composite annotation. Thereafter, you can deal with a single, grouped 
annotation rather than several, separate annotations. A grouped annotation 



behaves just like a single annotation. It can be moved, resized, sent to back, etc. 
You can also create groups that include group annotations.

To group annotations together

1. Select all of the annotations that you want to group together.
2. Choose the Group command from the Format menu.
3. The group will become a single group annotation.

To separate grouped annotations

1. Select the group annotation that you want to separate.
2. Choose the Ungroup command from the Format menu.
3. The group will be separated into individual annotations.

Locking

An annotation can be locked into place. For example, if you have a large 
annotation, like an imported image annotation, it is sometimes easy to 
accidently grab and move it while attempting to do something else. A locked 
annotation can't be selected and, hence, cannot be moved or resized. It will 
remain fixed at its current position until unlocked. 

To lock an annotation

1. Select the annotation(s) that you want to lock.
2. Choose the Lock command from the Format menu.
3. The annotation(s) will be locked and can't be selected or moved.

To unlock all annotations

1. Choose the Unlock command from the Format menu.
2. All locked annotations will be unlocked and can be selected and moved. You 

cannot unlock individual annotations since a locked annotation cannot be 



selected.

Working with Text

Two types of annotations contain text - note annotations and text annotations. 
The same techniques apply to editing the text in these annotations as apply to 
editing the text in any NeXT application.

This section just hits the high points of text editing. You can find additional 
information on working with text in the NeXT User's Reference manual.

Editing

You must first select the text that you want to edit. The cursor must be an I-
beam. You can select text in a variety of ways.



Do this To .

Click Place the insertion point into the text
Drag Select the text that you drag across
Alternate-click Select the text between the insertion point and 

the 
clicked point. It extends or shortens a selection.

Double-click Select a word.
Triple-click Select a line or paragraph.

Once you have selected a portion of text, then you can easily edit it.

Do this To .

Type some text Insert the typed text at the insertion point or 
replace the selected text with the typed text.

Press the Delete key Delete the selected text.
Choose the Delete com- Delete the selected text.
mand from the Edit menu
Choose the Cut command Remove the selected text and put it on the 
from the Edit menu pasteboard.
Choose the Copy command Put the selected text on the pasteboard.
from the Edit menu
Choose the Paste command Insert text from the pasteboard at the insertion
from the Edit menu point or replace the selected text with the paste-

board text.

Fonts and Formats

You can change the font and format of the text in a note annotation window 
and in a text annotation. However, you cannot change the font or format of the 
title of a note annotation button. 

The font of a piece of text includes its font family (Times or Helvetica), its 



typeface (medium or bold), and its size (10 point or 14 point). 

To tweak the text font

1. Select the portion of text to change.
2. Choose the appropriate command(s), such as Bold or Italic, from the Font 

menu to incrementally change the font.

To change the text font

1. Select the portion of text to change.
2. Choose the Font Panel command from the Font menu.
3. Select the family, typeface, and size.
4. Click Set to change the font.

While font changes apply only to the selected text characters, format changes 
apply to the entire paragraph. A paragraph is the text between Return 
characters. The format of a paragraph includes properties like its alignment.

To change the paragraph format

1. Place the insertion point or make a text selection in the paragraph to change.
2. Choose the appropriate command, such as Align Right, from the Format 

menu.

Find and Replace

You can search for and optionally replace words or phrases within note 
annotation windows and within text annotations. However, you can search only 
within a single annotation at a time. For example, to search for a word in all 
note annotations you must search in each one individually.

To find and replace text



1. Place the insertion point in the text where you want the search to start, 
usually at the beginning.

2. Choose the Find Panel command from the Find submenu in the Edit menu.
3. Enter the text to find and click Next to begin the search.

4. If text is found, it is selected and highlighted.
5. Use the Find panel to replace the selected word or to search for another 

occurrence.

6. You can also use the commands from the Find submenu of the Edit menu to 
find other occurrences of the search text. Find Next and Find Previous are 
equivalent to the Next and Previous buttons in the Find panel. Enter 
Selection is equivalent to typing the selected text into the Find field of the 
Find panel.

Spelling

You can check the spelling of words within note annotation windows and 



within text annotations. However, spelling is checked only within a single 
annotation at a time. For example, to check the spelling in all note annotations 
you must check each one individually.

To check spelling

1. Place the insertion point in the text where you want the checking to start, 
usually at the beginning. Do not place the insertion point within a word.

2. Choose the Check Spelling command from the Edit menu to start checking 
for misspelled words.

3. If a word that might be misspelled is found, it is selected and highlighted.
4. To see guesses at the correct spelling of the selected word, choose the 

Spelling command from the Edit menu.
5. Use the Spelling panel to correct the spelling of the selected word or to add 

it to your local dictionary.

Services from other Applications

During your review, you can take advantage of services provided by other 



applications through Redmark's Services menu. The services available to you 
depend upon the applications you have installed. Two types of services are 
available:
• document - for the current document
• selection - for the selected annotation or its contents.

An example of each type of service is given below. These services are provided 
by standard NeXT applications. Many other services are possible.

To attach current document to a NeXTmail message

1. Bring the document window to the front.
2. Choose the Mail Document command from the Services menu.
3. The document will be placed into the current e-mail message in NeXTmail. 

If necessary, the NeXTmail application will be run and a new send message 
opened.

To lookup a definition in Webster

1. Select the word in a text (or note) annotation.
2. Choose the Define in Webster command from the Services menu.
3. The definition will be presented in Webster. If necessary, the Webster 

application will be run automatically.

Customizing the Annotations

You can customize some or all of the proofreading marks in the Annotations 
palette. For example, if you never use the em-dash mark and would like to use 
rom to indicate a change to a Roman (plain) typeface, you can replace the 
standard em-dash mark button with one for your own Roman mark. 

Before you customize any proofreading marks, consider the following:
• Any customization will apply to all users of Redmark. That is, you cannot 



customize proofreading marks on a per-user basis. 
• The customized proofreading marks will only appear to users that run the 

customized version of Redmark. This may be a problem if you are sending 
marked up documents to remote users.

To customize a proofreading mark, you need to know how to use the Edit and 
Interface Builder applications and how to create a PostScript image. You 
should also know a little about PostScript programming. 

In the following example, we assume you want to replace the em-dash 
proofreading mark (named EmDash) with a new proofreading mark we'll call 
“Roman.” We also assume that you only want to do it for the English language.

1. Create an EPS image of your new “Roman” proofreading mark. You can 
use any drawing or illustration application that can generate an EPS file. Or, 
you can use Yap to create a PostScript program directly, then sandwich it 
between an EPS header and trailer.  

Redmark uses the bounding box of the EPS image to determine the original 
size of the proofreading mark. So, if you create your PostScript with Yap, 
be sure that there is a %%BoundingBox comment in the header.  

Once you have created your basic EPS image, you will want to customize it 
to work better as a Redmark annotation. You can control how the 
proofreading mark is resized using Redmark-specific PostScript comments 
and variables.

You may want to limit the way users can resize the proofreading mark. For 
example, you may want the mark to be resized only in the horizontal 
direction. You can constrain resizing by including a 

%%RedmarkResizing: type
PostScript comment in the EPS header.

This type Allows resizing
.

ASPECT In horizontal and vertical directions while maintaining 



the original aspect ratio.
DISTORT In arbitrary horizontal and vertical directions.
HORIZONTAL In horizontal direction only.
VERTICAL In vertical direction only.
NONE No resizing allowed.

For example, if you want the proofreading mark to be resized only in the 
horizontal direction, include a %%RedmarkResizing: HORIZONTAL 
comment. If you do not include a %%RedmarkResizing comment, the 
default is ASPECT.

When you resize (i.e., scale) a normal EPS image, the line widths are scaled 
in the same ratio as the image size. As the image gets larger, the lines get 
fatter. In many proofreading marks, you want the line width to remain 
constant regardless of the size of the mark. To let you maintain a constant 
line width, your PostScript code is responsible for scaling the image to fit 
the size of the proofreading mark. Redmark sets two PostScript “variables” 
RedmarkWidth and RedmarkHeight in userdict before executing your 
PostScript code. These variables are set to the scaled size of the 
proofreading mark. Your PostScript code can then use these two variables to 
scale the paths to be drawn without scaling the width of the line. See the 
CloseUp.eps file in the English.lproj directory inside the Redmark.app as an 
example of how to do this.

When you have finished your annotation image, put its EPS file into the 
English.lproj subdirectory (remember that, in our example, the change 
applies only to English) inside the Redmark.app application directory. Name 
the file Roman.eps (for our example).

2. Create an icon (usually a TIFF image) for the button in the Annotations 
palette. Although you can use the same image for both the icon and the 
proofreading mark,  a “tuned” TIFF image usually looks better as an icon in 
the palette. The icon size should be 32 x 32 pixels or smaller. You can use 
Icon Builder or any other application that can create a TIFF image.

Put the icon image file into the English.lproj subdirectory within 



Redmark.app (the same one as the EPS file). By convention, name the icon 
file RomanIcon.tiff (since you are creating the “Roman” proofreading 
mark). If you use separate images for the icon and the proofreading mark, 
they MUST be named differently (yes, even if they have different 
extensions).

3. Put the new icon into a button in the Annotations palette in Redmark using 
Interface Builder. Open the Redmark.nib file in the English.lproj 
subdirectory within Redmark.app. You will see that the Annotations panel 
consists of two Matrix objects containing ButtonCells – the bottom one 
containing proofreading marks. Replace the em-dash icon (EmDashIcon) 
with your new icon (RomanIcon) for the appropriate ButtonCell.

4. Annotations are defined in the Annotations.strings file in the English.lproj 
subdirectory within Redmark.app. In this Annotations.strings file, each 
proofreading mark has a definition line such as

"EmDashIcon"="ProofImage,EmDash";
The left side of the assignment gives the name of the icon file (i.e., 
EmDashIcon.tiff) while the second parameter on the right side gives the 
name of the EPS file (i.e., EmDash.eps). (The first parameter on the right 
side is the name of the object that handles the annotation.) Edit the 
Annotations.strings file to add a line defining your new proofreading mark

"RomanIcon"="ProofImage,Roman";

You should leave the definition of the standard proofreading mark in the 
file, because there may be existing documents in which that mark has been 
used. The standard proofreading mark can still be displayed; you just can't 
create it anymore.

We suggest that you don't customize the delete, insert, or transpose 
proofreading marks as you will loose their special features.



Chapter 6
Entering Comments

This chapter covers how to enter comments into your review overlay. In 
Redmark, your comments are referred to generically as annotations. You select 
a tool from the Annotations palette and use it to create an annotation in the 
review. An annotation can be a long text comment in the electronic equivalent 
of a sticky note, digitized voice using Lip Service, a short typed text comment, 
simple drawn graphics, a standard proofreading mark, an imported image for 
complex graphics, or an imported digitized sound. How you use the annotations 
to review the document is up to you. 

The Annotations Palette and Tools

The Annotations palette contains the "tools" you will use to make your 
comments. The Annotations palette is displayed whenever you create a new 
review or open an existing review. You can also explicitly display it by 
choosing the Annotations command from the Tools menu.

Selecting a Tool

You choose a tool from the Annotations palette by clicking on it. The tool you 
chose becomes the current tool and the button for that tool becomes 
highlighted. You draw or place your comment into the current review using the 
tool. 



Note One Annotations tool will always be highlighted whenever the use of 
tools is valid. If no tool is highlighted, you will not be able to choose an 
Annotations tool. Either you haven't created a review for the document 
or another reviewer's review is the current (top) review. (You can't 
modify another reviewer's review.) You can create a new review with 
the New Review command from the Document menu or bring your 
review to the top by choosing it from the reviews pop-up list at the 
bottom of the document window.

Using the Tool

With a tool selected, the shape of the cursor changes as you move the cursor 
over the current review. For example, with the rectangle tool selected the 
cursor changes from the pointer to a cross. The change indicates that you can 



now use the tool.

Tools fall into two categories: those that draw and those that place. As you 
might expect, tools that draw are used to create graphical annotations, like a 
rectangle, and tools that place are used to create text or symbols, like an 
"insert" proofreading mark.

You draw a drawable annotation by dragging out its shape in the review. You 
place a placeable annotation by clicking where you want the annotation placed 
in the review.

This tool type Creates annotations by
Sticky note Placing
Lip Service Placing
Direct text Placing
Simple graphics Drawing
Delete and transpose proofreading marks Placing or drawing
Other proofreading marks Placing

To draw a drawable annotation

1. Select a drawable tool, for example, a rectangle.
2. Click where you want one "corner" of the annotation to lie.

3. Drag the mouse across the diagonal of the area you want covered by the 
annotation. You can see the annotation being drawn and reshaped as you 
move the mouse.

4. When you have the annotation drawn like you want, release the mouse 
button.



To place a placeable annotation

1. Select a placeable tool, for example, an "insert" proofreading mark.
2. Click where you want the center of the annotation to lie.

3. The annotation is placed where you clicked.

If you didn't draw the annotation exactly like you wanted, don't worry. You 
can easily move and resize the annotation. Or, just press the Delete key to 
delete it and start over. We'll discuss moving and resizing in detail later in the 
Working with Annotations section.

Constraints

Some tools use the Alternate key, to enforce a constraint during the creation of 
an annotation. For example, the ellipse annotation tool draws a circle when the 
Alternate key is depressed.

The Alternate key with Forces this constraint on 
this tool the annotation .
Line and arrow Angle is multiple of 15®
Rectangle Square
Ellipse Circle

Sticky and Slippery Tools

The Annotations tools can be used in one of two modes: sticky or slippery. In 
"sticky" mode, a selected tool stays active after it is used. To change the tool, 
you must choose another tool. In "slippery" mode, the current tool is active for 
only one use and automatically slips back to the selector tool after being used 
once. (The selector tool is used for selecting, moving, and resizing 



annotations.) You select the tool mode you prefer as an individual preference.

If you are using sticky tools, you can force the selector tool to be active at any 
time by holding down the Control key. The cursor shape will change from the 
current tool's cursor shape to the pointer shape. With the Control key down, the 
cursor can be used just as if the selector tool was explicitly selected.

Tip Regardless of the tool mode you prefer, using the Control key to 
temporarily force the selector tool to be active is a very useful trick to 
learn. You should remember it. 

Annotation Inspectors

You can use the Annotation Inspector to see and change the attributes of tools 
and of annotations. The attributes of a tool or annotation include such things as 
its line width, whether it is framed or unframed, and whether it is filled or 
transparent. Each type of annotation (e.g., rectangle or Lip Service) has its own 
inspector. There are also a few types that do not have any changeable attributes 
and so do not have an inspector. 

The attributes of a tool are applied to the annotation created whenever that tool 
is used. For example, if you prefer that most rectangles have a thick frame, you 
can set the tool line width to thick using the Annotation Inspector. Any 
rectangles you create will have a thick frame. If you later decide that one of the 
rectangle annotations should have a medium width frame instead, you can select 



that particular annotation and change its line width to medium using the 
Annotation Inspector. The tool line width will remain thick.

Whether the inspector applies to a tool or to an annotation depends on whether 
any annotations are selected in the current review. If no annotations are 
selected, the Annotation Inspector applies to the current Annotations tool (the 
one highlighted in the Annotations palette). If any annotations are selected in 
the current review, the Annotation Inspector applies to those annotations, 
regardless of the tool that is selected. 

To set Annotations tool attributes

1. Choose the Inspector command from the Tools menu. 
2. Choose Annotation from the inspector type pop-up list in the Inspector 

panel.
3. Choose a tool from the Annotations palette. Make sure that no annotations 

are selected in the current review. If an annotation is selected, the word 
"Selection" will appear in the inspector instead of "Tool."

4. Set the attributes of the tool.



To set annotation attributes

1. Choose the Inspector command from the Tools menu. 
2. Choose Annotation from the inspector type pop-up list in the Inspector 

panel.
3. Select one or more annotations in the current review.  The word "Selection" 

will appear in the inspector, indicating that it applies to the currently 
selected annotation.

4. Set the attributes of the selected annotations. If several annotations are 
selected, only the attributes for the last annotation that was selected are 
shown. When you change an attribute while several annotations are selected, 



that attribute is changed in every selected annotation for which that attribute 
is applicable (e.g., some types of annotations do not have a line width).

The changes you make to Annotations tool attributes can be temporary or 
permanent. Temporary changes remain in effect only for the current Redmark 
session. Permanent changes remain in effect for future Redmark sessions, until 
you explicitly change them again. Each user has their own set of permanent 
tool attributes. Your changes do not affect any other users. You can determine 
whether your changes to tool attributes are temporary or permanent as part of 
your individual preferences.



Chapter 7
Revising the Original Document

This chapter discusses how the author collects the reviews submitted by 
reviewers and incorporates their comments into the revision of the original 
document. Revising the document is the last step in a review cycle iteration. 

Revising a document consists of two main steps:

1. Collect the comments submitted by the reviewers using Redmark.
2. Incorporate the reviewers' comments into the original document using both 

Redmark and the creating application simultaneously.

Remember, Redmark does not permit the reviewers to modify the original 
document. It is up to the author to evaluate all of the returned comments and 
revise the original document accordingly.

Collecting Reviewer Comments



You, the author, need to collect the reviews, which you receive as separate 
submittal documents, into one place, the original Redmark review package 
document. (See Distributing the Review Package in Chapter 4 for the different 
ways to review a document.) Having only one document that contains all of the 
reviews lets you easily monitor the status of the review cycle. It also allows you 
to flip through the reviews quickly when you revise the original document.

Note You only need to merge reviews that are received in documents separate 
from the original review package document. If the reviews are already a 
part of the original review package document, there's no need to merge.

Review method Need to
(see Chapter 4) Review received in merge?
Simultaneous Separate submittal document Yes
Sequential Routed review package document No
In-place Shared review package document No

To merge reviews into the review package

1. Open the original Redmark review package document using the Open 
command from the Document menu.

2. Select the review package document from the Open panel.
3. Choose the Merge Reviews command from the Distribute menu.

4. Select the submittal document from the Merge Reviews 
(open) panel.

5. The submitted reviews will be added to those already in the review package 
document. If there are any name conflicts between the existing and the new 
reviews, you must resolve them to keep review names unique.



6, After you have merged the submitted reviews, save the document using the 
Save command from the Document menu.

The Document History

Redmark maintains a chronological history of the document's review. This 
history includes all significant events, such as the distribution of the document 
and the submittal of each review. That is why it is important, though not 
mandatory, to "formally" distribute the document and to "formally" submit the 
reviews.

Monitoring Review Status

You can see the current document's history using the History Inspector. With it 
you can easily monitor the status of the review process. Thus, you can tell at a 



glance who has submitted their review and who has not.

To view the document history

1. Choose the Inspector command from the Tools menu. 
2. Choose History from the inspector type pop-up list in the Inspector panel.

Printing the Document History

If you want a paper record of the document's history, you can print it. 

To print the document history



1. Choose the History command from the Print menu. 
2. Use the standard Print panel to print, fax, or preview the document history.

To set the page layout for history

1. Choose the Page Layout command from the Format menu. 
2. Set the page layout for history using the Page Layout panel.



Incorporating Comments into the Original Document

The real goal of the review cycle, of course, is to revise the original document 
to make it better, based on the comments received from the reviewers. The 
easiest way to do this is to use Redmark side by side with the application that 
created the document. Then you can view the comments in Redmark while 
revising the document in the creating application. Also, you can easily copy 
comments from the reviews and paste them into the document.

Viewing the Reviews

You can use the ribbon of controls at the bottom of the document window to 
"flip through" the reviews. For more information on viewing reviews, see 
Multiple Reviews in Chapter 5.



Copy and Paste

By using Redmark and the creating application (the one used to create the 
document originally and to revise it now) simultaneously, you can easily copy 
comments from the reviews and paste them directly into the revised document. 
You can copy text (including its formatting and font information), graphics, 
images, and even sound from annotations in the current review and paste them 
into the revised document. 

To copy and paste comments

1. Click in the Redmark document window to make it the key (front) window. 
It's title bar will be black.

2. Make the review that contains the comments the current review by choosing 
it from the reviews pop-up list at the bottom of the document window. 

3. Select the desired annotation or its contents (i.e., text).
4. Choose the Copy command from Redmark's Edit menu. The comments will 

be copied to the pasteboard.
5. Click in the creating application's document to make it the key window. 
6. Select the location where the comments are to be placed in the revised 

document. How one does this depends upon the particular creating 
application. 

7. Choose the Paste command from the creating application's Edit menu. 
8. The comments will be copied from the pasteboard into the revised 

document.

More About Copy and Paste

Copy and paste sounds simple ... and usually is, even between two different 
applications. That's because the "right thing" magically happens when you copy 
and paste information between applications through the pasteboard. However, 
unexpected but explicable things do happen, so a brief discussion of the copy/



paste mechanism is in order. The pasteboard can contain the same information 
in multiple formats. For example, you can represent text in an editable format 
such as Rich Text or in an image format such as Encapsulated PostScript 
(EPS). When you copy to the pasteboard, the sending application supplies the 
information in as many formats as possible. Then, when you Paste from the 
pasteboard, the receiving application can determine which of the available 
formats it prefers and use that one for the paste. For example, a word 
processing application would choose Rich Text, while a drawing application 
might choose EPS.

Copying from Redmark

Redmark copies all annotations to the pasteboard in Redmark annotation 
(internal), EPS, and TIFF formats. Thus, they can be pasted back into Redmark 
as annotations and they can be pasted into other applications as images. Some 
annotation types copy additional formats. The following table indicates all of 
the formats that are copied onto the pasteboard when a Copy or Cut is 
performed on a particular type of annotation.

Puts these format, in order of
Copying or cutting preference, on the pasteboard

Note annotation Redmark annotation
Plain (ASCII) text
Rich Text
EPS
TIFF

Text annotation Redmark annotation
Plain (ASCII) text
Rich Text
EPS
TIFF

Text within a note or Plain (ASCII) text
text annotation Rich Text
Lip Service annotation Redmark annotation

Sound



EPS
TIFF

Other annotations Redmark annotation
EPS
TIFF

Tip There are some applications that unexpectedly prefer EPS or TIFF over 
plain text or Rich Text. One of these is Edit. If you paste a text or note 
annotation into those applications, the "text" will be an uneditable 
image. For these cases, rather than select and copy the entire annotation, 
you should select the text within the text annotation or the note 
annotation window and copy only the text to the pasteboard. 

Pasting into Redmark

For completeness, let's see how Redmark handles paste. When you paste into 
Redmark, a new annotation is created in the current review from the 
information on the pasteboard. To paste, the current review must be editable. 
You can indicate where you want the annotation placed by clicking at that 
location before pasting. The table below shows how Redmark converts various 
pasteboard formats into annotations. Starting from the top of the table, the first 
format that is encountered on the pasteboard is the one that will be used. For 
example, if you copy an annotation from Redmark and paste it back, you will 
get a duplicate of the copied annotation. If you copy a Rich Text selection from 
a word processor and paste it into Redmark, you will get a text annotation in 
the review. And, if you copy a graphic from a drawing application, you will 
get an image annotation when pasted into Redmark.

If this format is on the This type of annotation
pasteboard will be created .

Redmark annotation The same annotation
Rich Text Text annotation
Plain (ASCII) text Text annotation
EPS Image annotation



TIFF Image annotation
Sound Lip Service annotation

Paste also works as expected for text selections. If you have text selected and 
there is a compatible text format on the pasteboard, Paste will replace the 
selected text with the text from the pasteboard. For example, you can paste text 
into entry fields in the Inspector. Another use is to create a note annotation, 
open it, and paste text from the pasteboard into its window.

Chapter 8
Using Redview for View-Only

A view-only version of Redmark, called Redview for Redmark viewer, is 
available. Redview provides all of the view functionality of Redmark, but none 
of its markup functionality. In other words, you can use Redview to open a 
Redmark review package document and view the reviews. However, you cannot 
create a review package document and you cannot create or modify a review. 
The following table lists all the functions of Redmark (mostly as menu items/
commands) and indicates which ones can be performed in Redview.

Redmark Redview .
License Yes
Preferences If applicable
Open [document] Yes
Open Review Yes



New Document Yes
New Review No
Save Yes
Save As Yes
Save Review No
Revert to Saved No
Delete Review No
Miniaturize [document] Yes
Close [document] Yes
Close Review Yes
Cut No
Copy Yes
Paste No
Delete No
Find Yes
Spelling Yes, but no correction
Check Spelling Yes
Select All No
Deselect All No
Bring to Front No
Send to Back No
Group No
Ungroup No
Lock No
Unlock No
Alignment [paragraph] No
Page Layout Yes
Font No
Arrange in Front [windows] Yes
List of documents Yes
Close Window Yes
Annotation tools No
Document Inspector View only
Review Inspector View only
History Inspector Yes
Annotation Inspector No, can't select an annotation



Submit Reviews No
Distribute Document Yes
Merge Reviews Yes
Print Reviews Yes
Print History Yes
Services Yes
Hide [application] Yes
Quit [application] Yes

Chapter 9
Compatibility Issues

By design, Redmark must work with documents produced by many other 
applications. This brings up the issue of compatibility. To cover the broadest 
range of documents, Redmark uses a print-image PostScript file as the 
interchange document format. However, even though the structure of a 
PostScript file is a well-documented "standard" from Adobe, there is 
considerable variability in conformance to this standard. This chapter discusses 
the compatibility of Redmark with the print-image PostScript files produced by 
other NeXT applications and by applications on other computers.

Conforming PostScript

A print-image PostScript file contains a complete description of how to produce 
the formatted pages of a document. This file contains two types of elements:

• PostScript language commands (like lineto or show) that draw elements 
onto the page.



• PostScript structuring comments (like %%Page) that organize the document 
into sections, like a page.

Redmark does not interpret the PostScript language commands in a print-image 
file. That is the job of the NeXT Display PostScript interpreter. However, it 
does interpret the structuring comments. For example, Redmark needs to know 
where the commands for a page start and stop so it can paginate the document 
properly on the screen.

Adobe Systems Incorporated publishes the PostScript Document Structuring 
Conventions Specification that describes the proper way to organize a 
PostScript language document file. The standard NeXT printing mechanism 
conforms to this convention, so most NeXT applications do too (since they use 
it). However, most applications or printer drivers on other platforms seem to 
violate the convention in one way or another.
 

Epitome's commitment to you, the user, is that Redmark will support any 
PostScript file that roughly conforms to Adobe's structuring conventions.

If you find a PostScript file that Redmark is not compatible with, please let us 
know. See Chapter 1, Welcome to Redmark for customer support information.

Limitations

There are only two known types of PostScript files that Redmark cannot 
properly handle: 

1. Redmark cannot handle a PostScript file in which the pagination is done 
solely with showpage commands and the pages are not delimited by %
%Page comments. We have seen some PC applications that produce such 
files. Redmark does handle EPS files, which have no pagination.

2. Redmark cannot successfully print PostScript files whose pages are not truly 
independent. An example of page dependence is when the second page 



requires a font definition that is created on the first page. PostScript files 
produced by the current Macintosh printer driver define TrueType fonts in a 
page-order dependent manner. These Macintosh files can still be marked up 
using Redmark; they just cannot be printed. 

Fixing Non-conforming PostScript Files

A non-conformance problem with a print-image PostScript file often manifests 
itself as a problem in rendering the document image. For example, the 
document image may be turned sideways on the page or may be off center. You 
can use the Document Inspector to manipulate the document image and correct 
many of these problems. See Correcting a Non-conforming Document Image in 
Chapter 4 for details.

Another common problem is garbage characters appearing in a PostScript file. 
This may happen as the result of transferring the PostScript file from another 
type of computer. Redmark tries to ignore obvious garbage at the beginning 
and end of the PostScript file, but internal garbage will cause a PostScript 
error. Since PostScript files are simply text files, you can edit them using Edit 
and often remove the offending garbage.

Redmark tries to be robust when a PostScript error is encountered. It will X out 
the page containing the problem, but attempt to render the other pages in the 
document. 



Known Compatible Applications

Redmark is continually being tested for compatibility with applications, 
especially new applications for the NeXT. It is also being tested for 
compatibility with applications on other major computer platforms and 
operating systems - the IBM PC and compatibles running DOS and Windows, 
the Apple Macintosh, the Sun Microsystems 3 and SPARC series, and the 
Digital Equipment Corporation VAX line, just to name a few.



In order to provide you with the most up-to-date information on compatibility, 
a list of applications that Redmark has been tested with is contained in the 
"readme" file included in the distribution. If you are using an application that is 
not listed, contact Redmark customer support for information.
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